TITLE: SOFTWARE ARCHITECTURE DOCUMENT GUIDELINE VERSION 3.0

AUTHORS:
Ken Jensen (Raytheon Information Solutions)

SOFTWARE ARCHITECTURE DOCUMENT GUIDELINE
VERSION HISTORY SUMMARY

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>New Documentation Guideline adapted from CMMI practices and Raytheon practices by Ken Jensen (Raytheon Information Solutions)</td>
<td>New Document</td>
<td>12/29/2006</td>
</tr>
<tr>
<td>2.0</td>
<td>Revised by Ken Jensen (Raytheon Information Solutions) for version 2.</td>
<td>2</td>
<td>10/12/2007</td>
</tr>
<tr>
<td>3.0</td>
<td>Revised by Ken Jensen (Raytheon Information Solutions) for version 3.</td>
<td>2</td>
<td>10/1/2009</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST OF FIGURES</td>
<td>5</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>5</td>
</tr>
<tr>
<td>LIST OF ACRONYMS</td>
<td>6</td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td>7</td>
</tr>
<tr>
<td>1.1. Objective</td>
<td>7</td>
</tr>
<tr>
<td>1.2. The Software Architecture Document</td>
<td>7</td>
</tr>
<tr>
<td>1.3. Background</td>
<td>9</td>
</tr>
<tr>
<td>1.4. Benefits</td>
<td>9</td>
</tr>
<tr>
<td>2. REFERENCE DOCUMENTS</td>
<td>10</td>
</tr>
<tr>
<td>3. STANDARD TABLE OF CONTENTS</td>
<td>13</td>
</tr>
<tr>
<td>4. SECTION GUIDELINES</td>
<td>15</td>
</tr>
<tr>
<td>4.1. Table of Contents</td>
<td>15</td>
</tr>
<tr>
<td>4.2. List of Figures</td>
<td>15</td>
</tr>
<tr>
<td>4.3. List of Tables</td>
<td>15</td>
</tr>
<tr>
<td>4.4. List of Acronyms</td>
<td>16</td>
</tr>
<tr>
<td>4.5. Section 1 – Introduction</td>
<td>16</td>
</tr>
<tr>
<td>4.6. Section 2 – Architecture Description</td>
<td>17</td>
</tr>
<tr>
<td>4.7. Section 3 – Assumptions and Limitations</td>
<td>24</td>
</tr>
<tr>
<td>4.8. Section 4 – List of References</td>
<td>24</td>
</tr>
<tr>
<td>APPENDIX A - EXAMPLES</td>
<td>25</td>
</tr>
<tr>
<td>APPENDIX B - TEMPLATES</td>
<td>26</td>
</tr>
</tbody>
</table>
LIST OF FIGURES

Figure 5.1 – Example of a Context-Layer Data Flow Diagram ........................................... 18
Figure 5.2 – Example of a System-Layer Data Flow Diagram .......................................... 20
Figure 5.3 – Example of a Unit-Layer Data Flow Diagram ................................................. 22
Figure 5.4 – Example of a Sub-Unit-Layer Data Flow Diagram .......................................... 23
Figure B.1 - <Figure caption in Arial regular 12 point font> ................................................ 30

LIST OF TABLES

Table 5.1 – Example of a Context-Layer Data Flow Table ................................................. 19
Table 5.2 – Example of a System-Layer Data Flow Table ................................................. 21
Table 5.3 – Example of a Unit-Layer Data Flow Table ....................................................... 24
Table B.1 - <Table title in Arial regular 12 point font> ........................................................ 30
## LIST OF ACRONYMS

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR</td>
<td>Critical Design Review</td>
</tr>
<tr>
<td>CICS</td>
<td>Cooperative Institute for Climate Studies</td>
</tr>
<tr>
<td>CIMSS</td>
<td>Cooperative Institute for Meteorological Satellite Studies</td>
</tr>
<tr>
<td>CI OSS</td>
<td>Cooperative Institute for Oceanographic Satellite Studies</td>
</tr>
<tr>
<td>CIRA</td>
<td>Cooperative Institute for Research in the Atmosphere</td>
</tr>
<tr>
<td>CL</td>
<td>Checklist</td>
</tr>
<tr>
<td>CMMI</td>
<td>Capability Maturity Model Integration</td>
</tr>
<tr>
<td>CREST</td>
<td>Cooperative Remote Sensing and Technology Center</td>
</tr>
<tr>
<td>CUTR</td>
<td>Code Unit Test Review</td>
</tr>
<tr>
<td>DG</td>
<td>Document Guideline</td>
</tr>
<tr>
<td>EPL</td>
<td>Enterprise Project Lifecycle</td>
</tr>
<tr>
<td>NESDIS</td>
<td>National Environmental Satellite, Data, and Information Service</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>PAL</td>
<td>Process Asset Library</td>
</tr>
<tr>
<td>PDR</td>
<td>Preliminary Design Review</td>
</tr>
<tr>
<td>PRG</td>
<td>Peer Review Guideline</td>
</tr>
<tr>
<td>PRR</td>
<td>Project Requirements Review</td>
</tr>
<tr>
<td>R&amp;D</td>
<td>Research &amp; Development</td>
</tr>
<tr>
<td>RAD</td>
<td>Requirements Allocation Document</td>
</tr>
<tr>
<td>SEP</td>
<td>Systems Engineering Processes</td>
</tr>
<tr>
<td>SPSRB</td>
<td>Satellite Products and Services Review Board</td>
</tr>
<tr>
<td>SRR</td>
<td>System Readiness Review</td>
</tr>
<tr>
<td>STAR</td>
<td>Center for Satellite Applications and Research</td>
</tr>
<tr>
<td>SWA</td>
<td>Software Architecture Document</td>
</tr>
<tr>
<td>TD</td>
<td>Training Document</td>
</tr>
<tr>
<td>TG</td>
<td>Task Guideline</td>
</tr>
<tr>
<td>TRR</td>
<td>Test Readiness Review</td>
</tr>
<tr>
<td>VVP</td>
<td>Verification and Validation Plan</td>
</tr>
</tbody>
</table>
1. **INTRODUCTION**

The NOAA/NESDIS Center for Satellite Applications and Research (STAR) develops a diverse spectrum of complex, often interrelated, environmental algorithms and software systems. These systems are developed through extensive research programs, and transitioned from research to operations when a sufficient level of maturity and end-user acceptance is achieved. Progress is often iterative, with subsequent deliveries providing additional robustness and functionality. Development and deployment is distributed, involving STAR, the Cooperative institutes (CICS, CIMSS, CIOSS, CIRA, CREST) distributed throughout the US, multiple support contractors, and NESDIS Operations.

NESDIS/STAR is implementing an increased level of process maturity to support the exchange of these software systems from one location or platform to another. The Software Architecture Document (SWA) is one component of this process.

1.1. **Objective**

The objective of this Document Guideline (DG) is to provide STAR standards for the SWA. The intended users of this DG are the personnel assigned by the Project Lead to the task of creating an SWA for the project.

1.2. **The Software Architecture Document**

The STAR Enterprise Product Lifecycle (EPL)\(^1\) provides for two SWA versions (v1 and v2). SWA version 1 has one planned revision. SWA version 2 has one planned revision.

SWA v1.0 is produced during the Basic Research phase of the STAR EPL as an artifact for the Gate 1 Review \(^2\). At this phase, the algorithm is at a “concept” stage and its operational potential has not been assessed. The SWA complements the Algorithm Theoretical Basis Document (ATBD) by providing the software architecture for the processing code that will implement the algorithm. The purpose of SWA v1.0 is to assist in demonstrating to the Gate 1 reviewers that the algorithm has operational potential and should be further developed. The intended target audience is other scientists and managers at the algorithm developer’s agency.

---

\(^1\) For a description of the STAR EPL, refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A).

\(^2\) Refer to the STAR EPL Process Guidelines (PG-1 and PG-1.A) for a description of the STAR EPL gates and reviews.
SWA v1.1 is produced during the Exploratory phase of the STAR EPL as an artifact for the Gate 2 Review. At this phase, the algorithm's operational potential has been demonstrated to the satisfaction of the developer's agency and is now being further developed into a STAR research project proposal. The purpose of SWA v1.1 is to assist in demonstrating to the Gate 2 reviewers that the algorithm should be developed as a STAR research project. The intended target audience is STAR scientists and managers.

SWA v2.0 is produced during the Design phase of the STAR EPL as an artifact for the Preliminary Design Review (PDR). At this phase, the algorithm has been approved by STAR and is being further developed as a pre-operational product with oversight from STAR. The purpose of SWA v2.0 is to demonstrate to the PDR reviewers that the algorithm preliminary design satisfies STAR EPL design requirements. The intended target audience includes STAR scientists and the PDR reviewers.

SWA v2.1 is produced during the Design phase of the STAR EPL as an artifact for the Critical Design Review (CDR). At this phase, the algorithm has been approved by STAR and is being further developed as a pre-operational product with oversight from STAR. The purpose of SWA v2.1 is to help demonstrate to the CDR reviewers that the software detailed design provides for an implementation that is consistent with the theoretical basis and meets requirements. The intended target audience includes STAR scientists and the CDR reviewers.

SWA v2.2 is produced during the Build phase of the STAR EPL as an artifact for the Test Readiness Review (TRR). SWA v2.2 is typically updated from the CDR version (v2.1), to document revisions to the software architecture that occur during pre-operational code development. The intended target audience includes STAR scientists and the TRR Reviewers.

SWA v2.3 is the final planned SWA version. It is produced during the Build phase of the STAR EPL as an artifact for the Code Test Review (CTR). SWA v2.3 is typically updated from the TRR version (v2.2), to document revisions to the software architecture that occur as a result of unit testing. The intended target audience includes STAR scientists and the CTR Reviewers.

The SWA is prepared by the lead algorithm developer, with assistance from other scientists and development programmers as assigned by the developers’ agency (v1) or the Project Lead (v2).

The SWA should be developed as a Microsoft Word document. Upon approval, the approved version of the SWA may be converted to an Adobe pdf file for storage in the project artifact repository.
1.3. Background

This DG defines guidelines for producing an SWA. This DG has been adapted from Capability Maturity Model Integrated (CMMI) for Development V1.2 guidelines and practices (http://www.sei.cmu.edu/publications/documents/06.reports/06tr008.html) and from Raytheon practices. It has been tailored to fit the STAR EPL process.

1.4. Benefits

An SWA developed in accordance with the standards in this DG assists the research team to write prototype code that demonstrates the algorithm’s operational potential. It also assists the development team to write pre-operational code that implements the product preliminary and detailed design. It is therefore a requirement that an SWA be developed in accordance with the guidelines in this document before pre-operational code is approved for transition to operations.

1.4.1. Overview

This DG contains the following sections:

- Section 1.0 - Introduction
- Section 2.0 - References
- Section 3.0 - Standard Table of Contents
- Section 4.0 - Section Guidelines
- Appendix A - Examples
- Appendix B - Templates
2. REFERENCE DOCUMENTS

All of the following references are STAR EPL process assets that are accessible in a STAR EPL Process Asset Repository (PAR) on the STAR web site:


PG-1: STAR EPL Process Guideline provides the definitive description of the standard set of processes of the STAR EPL.

PG-1.A: STAR EPL Process Guideline Appendix, an appendix to PG-1, is a Microsoft Excel file that contains the STAR EPL process matrix (Stakeholder/Process Step matrix), listings of the process assets and standard artifacts, descriptions of process gates and reviews, and descriptions of stakeholder roles and functions.

DG-0.1: STAR Document Style Guideline is a STAR EPL Document Guideline (DG) that provides STAR standards for the style and appearance of STAR documents developed as Microsoft Word files.

PRG-1: Gate 1 Review Guidelines are the guidelines for the Gate 1 Review. It is useful for the developer of SWA v1.0 to understand what the reviewers will expect when reviewing the SWA.

CL-1: Gate 1 Review Check List is the check list for the Gate 1 Review. It is useful for the developer of SWA v1.0 to understand the specific check list items (CLI) that the reviewers of the SWA will be required to approve.

PRG-3: Gate 2 Review Guidelines are the guidelines for the Gate 2 Review. It is useful for the developer of SWA v1.1 to understand what the reviewers will expect when reviewing the SWA.

CL-3: Gate 2 Review Check List is the check list for the Gate 2 Review. It is useful for the developer of SWA v1.1 to understand the specific check list items (CLI) that the reviewers of the SWA will be required to approve.
PRG-7: Preliminary Design Review Guidelines are the guidelines for the PDR. It is useful for the developer of SWA v2.0 to understand what the reviewers will expect when reviewing the SWA.

CL-7: Preliminary Design Review Check List is the check list for the PDR. It is useful for the developer of SWA v2.0 to understand the specific CLI that the reviewers of the SWA will be required to approve.

PRG-8.1: Critical Design Review Guidelines are the guidelines for the CDR. It is useful for the developer of SWA v2.1 to understand what the reviewers will expect when reviewing the SWA.

CL-8.1: Critical Design Review Check List is the check list for the CDR. It is useful for the developer of SWA v2.1 to understand the specific CLI that the reviewers of the SWA will be required to approve.

PRG-9: Test Readiness Review Guidelines are the guidelines for the TRR. It is useful for the developer of SWA v2.2 to understand what the reviewers will expect when reviewing the SWA.

CL-9: Test Readiness Review Check List is the check list for the TRR. It is useful for the developer of SWA v2.2 to understand the specific CLI that the reviewers of the SWA will be required to approve.

PRG-10: Code Test Review Guidelines are the guidelines for the CTR It is useful for the developer of SWA v2.3 to understand what the reviewers will expect when reviewing the SWA.

CL-10: Code Test Review Check List is the check list for the CTR. It is useful for the developer of SWA v2.3 to understand the specific CLI that the reviewers of the SWA will be required to approve.

DG-0.1: STAR Document Style Guideline is a STAR EPL Document Guideline (DG) that provides STAR standards for the style and appearance of STAR documents developed as Microsoft Word files

SG-14: STAR EPL Development Scientist Guidelines provides a description of standard tasks for Development Scientists, including development of SWA v2.

TG-1: STAR EPL Basic Research Task Guidelines provides a description of standard tasks for process step 1, during which SWA v1.0 is developed.

TG-3: STAR EPL Project Proposal Task Guidelines provides a description of standard tasks for process step 3, during which SWA v1.1 is developed.

TG-7: STAR EPL Preliminary Design Task Guidelines provides a description of standard tasks for process step 7, during which SWA v2.0 is developed.

TG-8: STAR EPL Detailed Design Task Guidelines provides a description of standard tasks for process step 8, during which SWA v2.1 is developed.

TG-9: STAR EPL Code Development and Test Task Guidelines provides a description of standard tasks for process step 9, during which SWA v2.2 is developed.

TG-10: STAR EPL Code Test and Refinement Task Guidelines provides a description of standard tasks for process step 10, during which SWA v2.3 is developed.
3. STANDARD TABLE OF CONTENTS

LIST OF FIGURES

LIST OF TABLES

LIST OF ACRONYMS

1.0 INTRODUCTION

1.1 Purpose

1.2 Intended Users

1.3 Revisions

1.4 Document Overview

2.0 ARCHITECTURE DESCRIPTION

2.1 External Interfaces

2.2 System Layer Data Flow

2.3 Unit Layer Data Flow

2.3.1 Unit 1

2.3.1.1 Sub-unit 1 Layer 3 Data Flow

2.3.1.2 Sub-unit 2 Layer 3 Data Flow

2.3.1.3 Etc.

2.3.1.N Sub-unit N Layer 3 Data Flow

2.3.1.N+1 Data Flow Table

2.3.2 Unit 2

2.3.2.1 Sub-unit 1 Layer 3 Data Flow

2.3.2.2 Sub-unit 2 Layer 3 Data Flow

2.3.2.3 Etc.

2.3.2.N Sub-unit N Layer 3 Data Flow

2.3.2.N+1 Data Flow Table

2.3.3 Etc.
3.0 ASSUMPTIONS AND LIMITATIONS

3.1 Assumptions

3.2 Limitations

4.0 LIST OF REFERENCES
4. SECTION GUIDELINES

This section contains the STAR guidelines for each section of the SWA.

The SWA should follow the STAR standard for style and appearance, as stated in DG-0.1.

4.1. Table of Contents

The Table of Contents can be inserted by using Word’s Insert → Reference → Index and Tables → Table of Contents function or by pasting the Table of Contents from this DG into your document and updating it for the section headers you make for your document. Use a page break if necessary to ensure that the Table of Contents appears at the top of a page.

4.2. List of Figures

A List of Figures should be provided after the Table of Contents. A page break should be used if necessary to ensure that the List of Figures appears at the top of a page. To create a List of Figures, use Word’s Insert → Reference → Index and Tables → Table of Figures function, selecting the “Table of Figures” Style. Alternatively, the List of Figures can be created by pasting the List of Figures for this DG into your document.

Figures should be created by using Word’s Insert → Picture → From File function or Word’s Insert → Object function. Figures should be numbered X.Y, where X is the main section number where the figure resides and Y = 1,N is the ordered number of the figure in the section. Figure captions should have Arial bold 12 point font, should be center justified, and should have a “Table of Figures” Style. A Figure Caption template is provided in Appendix B of this DG.

4.3. List of Tables

A List of Tables should be provided after the List of Figures. The List of Tables can appear on the same page as the List of Figures, with three blank lines separating them, provided both lists can fit on the same page. If both lists cannot fit on the same page, a page break should be used to ensure that the List of Tables appears at the top of a page.

To create a List of Tables, use Word’s Insert → Reference → Index and Tables → Table of Figures function, selecting the “Table - Header” Style. Alternatively, the List of Tables can be created by pasting the List of Tables for this DG into your document.
Tables should be created with the Table ➔ Insert ➔ Table function. Tables should be numbered X.Y, where X is the main section number where the table resides and Y = 1,N is the ordered number of the table in the section. Table titles should have Arial bold 12 point font, should be center justified, and should have a “Table - Header” Style. A Table Title template is provided in Appendix B of this DG. Table text should have Arial regular 10 point font.

4.4. List of Acronyms

The use of acronyms is encouraged. A two word or longer name for an item (e.g., Research Project Plan) should be given an acronym (e.g., RPP) if the name is used more than once in the document. A List of Acronyms should be provided after the List of Tables. The List of Acronyms should be in alphanumeric order. Use the List of Acronyms in this DG as a template. A page break should be used if necessary to ensure that the List of Acronyms appears at the top of a page.

4.5. Section 1 – Introduction

The SWA shall include an Introduction Section. This section shall include

- A well-defined purpose and function for the document
- Specific intended user(s) and how they should use the document
- A brief overview of the contents of each main section
- A revision/change history, focusing on updates since the previous revision

The standard purpose and function of the SWA version 1, as described in the Focused R&D Task Guideline (TG-2.3), is to provide a description of the Focused R&D algorithm data flows in sufficient detail to guide the writing of research grade code to test the algorithm. At this stage, there is no requirements allocation.

The standard purpose and function of the SWA version 2, as described in the Pre-Operational Algorithm Task Guideline (TG-9.3), is to demonstrate that the algorithm process flow provides for an implementation that is consistent with the theoretical basis and will satisfy the requirements allocation.
Specific intended users of SWA version 1 are the research grade code programmers and test reviewers. The programmers should use SWA version 1 as a guide for writing the research grade code. Gate 1 and Gate 2 reviewers should use SWA version 1 as a reference to help them verify the functionality of the research grade code.

Specific intended users of SWA version 2 are the pre-operational code programmers and the pre-operational requirements and design reviewers. The programmers should use SWA version 2 as a guide for writing the pre-operational code. Requirements reviewers should use SWA version 2 as a reference to help them verify that requirements have been satisfactorily allocated to product components. Design reviewers should use SWA version 2 as a reference to help them verify that the design properly implements the algorithm in a way that ensures the requirements allocation will be satisfied.

4.6. Section 2 – Architecture Description

The software system is an integrated collection of software elements, or code, which produce well-defined output products from a well-defined set of input data. The system layer architecture describes the structure of the system and the external and internal data flows between software elements.

List all software elements of the system. Provide a description of each element at a level of detail sufficient for programmers and reviewers to understand the function and data flows for each software element from the external interfaces down to the subprograms. Subsections should include Interfaces, System Layer Data Flow, and Unit Layer Data Flow.

The subsection for Interfaces should show all external inputs and outputs to and from the software system. An external input is defined as a data source needed by the system that is produced or made available by a process external to the system. Examples are raw sensor data, ancillary data, etc. External output is defined as a data sink that is produced by the system for an external user; for example, archived environmental products (e.g. Sea Surface Temperature). It is recommended that the interfaces be shown as a data flow diagram and as a table.

The data flow diagram should be at a “Context” layer (Layer-0), as shown in Figure 5.1.
Figure 5.1 – Example of a Context-Layer Data Flow Diagram
The table should list the Name of the interface item, its type (Input or Output), its source, and a description. An example is shown as Table 5.1.

### Input and Output Data Flows at the System Context-Layer

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Column Ozone</td>
<td>Input</td>
<td>NCEP</td>
<td>NCEP total column ozone, regridded to the moderate resolution VIIRS swath</td>
</tr>
<tr>
<td>Calibrated Radiance</td>
<td>Input</td>
<td>VIIRS</td>
<td>VIIRS calibrated radiance in bands I1, I2, and I3, at the imagery resolution VIIRS swath</td>
</tr>
<tr>
<td>VIIRS Snow Binary Map</td>
<td>Output</td>
<td>VIIRS Snow/Ice System</td>
<td>Snow binary map, at the imagery resolution VIIRS swath, with associated metadata, Earth location, and quality flags</td>
</tr>
</tbody>
</table>

**Table 5.1 – Example of a Context-Layer Data Flow Table**

The subsection System Layer Data Flow expands upon the context-layer diagram shown in Figure 5.1, showing the first layer of decomposition. In addition to the system-layer inputs and outputs, the major processing units are shown along with their inputs and outputs. Each unit is designed as a stand-alone program for ease of testing and integration into a system-layer scheduler. Each second-layer processing element should be described (e.g., "9.1 Snow Cover. Derives the binary snow map at imagery pixel resolution and snow fraction at moderate pixel resolution. Produces the VIIRS Snow Cover EDR, consisting of Snow Binary Map and Snow Fraction."). It is recommended that the interfaces be shown as a data flow diagram and as a table.
The data flow diagram should be at a “System” layer (Layer-2), as shown in Figure 5.2.

Figure 5.2 – Example of a System-Layer Data Flow Diagram
The table should list the Name of each system-layer data flow item, its type (Input, Internal, or Output), its source, and a description. An example is shown as Table 5.2

### Input, Internal, and Output Data Flows at the System-Layer

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Column Ozone</td>
<td>Input</td>
<td>NCEP</td>
<td>NCEP total column ozone, regridded to the moderate resolution VIIRS swath</td>
</tr>
<tr>
<td>Ice Concentration IP</td>
<td>Internal</td>
<td>VIIRS Snow/Ice System</td>
<td>Ice concentration and associated weights on the VIIRS imagery swath</td>
</tr>
<tr>
<td>VIIRS Sea Ice Characterization EDR</td>
<td>Output</td>
<td>VIIRS Snow/Ice System</td>
<td>Sea ice concentration, on the VIIRS imagery swath, with associated metadata, Earth location, weights, and quality flags. Sea ice age classification, at HCS resolution (3 x 3 imagery pixels), with associated metadata, Earth location, weights, and quality flags.</td>
</tr>
</tbody>
</table>

Table 5.2 – Example of a System-Layer Data Flow Table

The subsection Unit Layer Data Flow further decomposes the layer-2 diagram shown in Figure 5.2. The layer-2 processes are broken down into their constituent parts for each unit in the system. The unit-layer and sub-unit-layer data flows are described in a table following each set of unit-layer diagrams. There should be subsections for each unit in the system. For each subsection, do the following:
Show the data flow diagram at a “Unit” layer (Layer-3). For example, the Layer-3 data flow for process “9.1 Snow Cover”, indicated with the red arrow in Figure 5.2, is shown in Figure 5.3.

Figure 5.3 – Example of a Unit-Layer Data Flow Diagram
Following the unit-layer data flow diagram, show the data flows at the sub-unit layer in succeeding figures. For example, Figure 5.4 shows the sub-unit data flow for layer 3 process “9.1.7 Determine Snow Binary Map”, which is indicated by the red arrow in Figure 5.3.

**Figure 5.4 – Example of a Sub-Unit-Layer Data Flow Diagram**
The table should list the Name of each unit-layer data flow item, its type (Input, Internal, or Output), its source, and a description. An example is shown as Table 5.3

### Input and Output Data Flows at the Unit-Layer

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Column Ozone</td>
<td>Input</td>
<td>NCEP</td>
<td>NCEP total column ozone, regridded to the moderate resolution VIIRS swath</td>
</tr>
<tr>
<td>Snow Type</td>
<td>Internal</td>
<td>VIIRS Snow/Ice System</td>
<td>The derived snow type at the moderate resolution VIIRS swath</td>
</tr>
<tr>
<td>VIIRS Snow Binary Map EDR</td>
<td>Output</td>
<td>VIIRS Snow/Ice System</td>
<td>Snow binary map, at the imagery resolution VIIRS swath, with associated metadata, Earth location, and quality flags</td>
</tr>
</tbody>
</table>

Table 5.3 – Example of a Unit-Layer Data Flow Table

### 4.7. Section 3 – Assumptions and Limitations

State all assumptions that were made in determining that the software system architecture as designed will meet the requirements. Assumptions can be on the quality, latency and availability of inputs and on the capabilities of the processing environment. If an assumption may be questionable, note this as a risk.

State all identified limitations that may impact on the system’s ability to meet requirements. If a limitation poses a requirements risk, note this.

### 4.8. Section 4 – List of References

This section should consist of a List of References that includes all references cited in the document. Include all references deemed useful by the Product Team. References should be listed in alphabetical order. References that begin with an author list should begin with the last name of the lead author. A template is provided in Appendix B.
APPENDIX A - EXAMPLES

An example of an SWA that follows the STAR standards and guidelines will be developed and made accessible from the STAR Process Asset Repository (PAR).
APPENDIX B - TEMPLATES

This appendix contains templates for specific pages and sections of the SWA.
B.1 Cover Page Template:

In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc. <Project Name> should be the actual approved name of the Project.

NOAA NESDIS CENTER for SATELLITE APPLICATIONS and RESEARCH

<Project Name>
SOFTWARE ARCHITECTURE DOCUMENT
Version <X>
B.2 Document Header Template:
In this template, \( <X> = 1.0 \) for version 1, \( <X> = 1.1 \) for version 1 revision 1, \( <X> = 2.0 \) for version 2 etc.

In this template, \( <\text{Project Name}> \) should be the actual approved name of the Project.

In this template, \( <Y> = \) the actual page number.

In this template, \( <Z> = \) the actual total number of pages

NOAA/NESDIS/STAR
SOFTWARE ARCHITECTURE DOCUMENT
Version: \( <X> \)
Date: \( <\text{Date of Latest Signature Approval}> \)

\(<\text{Project Name}>\)
Software Architecture Document

Page \( <Y> \) of \( <Z> \)

B.3 Document Cover Page Footer Template:

Hardcopy Uncontrolled

B.4 Document Footer Template:

Hardcopy Uncontrolled
B.5 Version History Page Template:

In this template, \(<X> = 1.0\) for version 1, \(<X> = 1.1\) for version 1 revision 1, \(<X> = 2.0\) for version 2 etc. <Project Name> should be the actual approved name of the Project.

TITLE: <PROJECT NAME> SOFTWARE ARCHITECTURE DOCUMENT VERSION \(<X>\)

AUTHORS:

<Lead Author>

<Co-Author 1>

<etc.>

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Created by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Gate 1 Review.</td>
<td>New Document</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.1</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Gate 2 review</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.0</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Preliminary Design Review.</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>[Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Critical Design Review</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.2</td>
<td>[Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Test Readiness Review</td>
<td>Ditto</td>
<td>Ditto</td>
</tr>
<tr>
<td>2.3</td>
<td>[Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Code Test Review</td>
<td>Ditto</td>
<td>Ditto</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
B.6 Figure Caption Template:

Figure B.1 - <Figure caption in Arial regular 12 point font>

B.7 Table Title Template:

Table B.1 - <Table title in Arial regular 12 point font>
B.8 List of References Template:


END OF DOCUMENT